Chapter 8

Building Complex Queries

Creating queries on a single table as you did in the previous chapter is a good way to get acquainted with the basic mechanics of the query designer. It's also useful to work with simple queries to understand how datasheets work.

However, for many tasks you'll need to build a query on multiple tables or queries (yes, you can build a query on a query!), calculate totals, add parameters, customize query properties, or work in SQL view. In fact, there are some types of queries that you can build only in SQL view. This chapter shows you how.

Selecting Data from Multiple Tables

At this point, you've been through all the variations on a single theme—queries on a single table. It's easy to build on this knowledge to retrieve related information from many tables and to place that information in a single view. You'll find this ability to select data from multiple tables very useful in designing forms and reports.

NOTE
The examples in this chapter are based on the tables and data in HousingDataCopy.mdb and ContactsDataCopy.mdb on the companion CD included with this book. These databases are copies of the data from the Housing and LawTrack Contacts application samples, respectively, and they contain the sample queries used in this chapter. The query results you see from the sample queries you build in this chapter might not exactly match what you see in this book if you have changed the sample data in the files. Also, all the screen images in this chapter were taken on a Windows XP system with the display theme set to Windows XP. Your results may look different if you are using a different operating system or a different theme.

Creating Inner Joins

A join is the link you need to define between two related tables in a query so that the data you see makes sense. If you don't define the link, you'll see all rows from the first table combined with all rows from the second table (also called the Cartesian product). When you use an inner join (the default for joins in queries), you won't see rows from either table that don't have a matching row in the other table. This type of query is called an equi-join query, meaning that you'll see rows only where there are equal values in both tables. For example, in a query that joins departments and employees, you won't see any departments that have no employees or any employees that aren't assigned to a department. To see how to build a query that returns all rows from one of the tables, including rows that have no match in the related table, see “Using Outer Joins.”

As you learned in Chapter 3, “Designing Your Database Application,” correctly designing your tables requires you to split out (normalize) your data into separate tables to avoid redundant data and problems updating the data. For many tasks, however, you need to work with the data from multiple tables. For example, in the Housing application, to work with Employees and the Departments to which they are assigned, you can't get all the information you need from just tblEmployees. Sure, you can see the employee's DepartmentID, but what about the department name and location? If you want to sort or filter employees by department name, you need both tblDepartments and tblEmployees.

In the previous chapter, we built several queries on tblReservations. Because that table has Lookup properties defined, you can see the facility name in the reservation record, but as you discovered, that's really a numeric field. If you want to sort on the real name value or see other information about the facility, you must create a query that uses both tblFacilities and tblReservations.

Try the following example, in which you combine information about a reservation and about the facility in which the reservation was confirmed. Start by opening the HousingDataCopy.mdb database. Click the Queries button, and then click the New button. Select Design View in the New Query dialog box, and click OK to open a new Query window in Design view. Access immediately opens the Show Table dialog box. In this dialog box, you select tables and queries that you want in your new query. Select the tblFacilities and tblReservations tables (hold down the Ctrl key as you click each table name), click the Add button, and then close the dialog box.

Troubleshooting
How can I be sure I'm using the correct table in the query designer?

It's a good idea to select the Show Table Names option on the Tables/Queries tab of the Options dialog box (choose the Options command from the Tools menu) whenever your query is based on more than one table. Because you might have the same field name in more than one of the tables, showing table names in the design grid helps to ensure that your query refers to the field you intend it to.

Whenever you have relationships defined, the query designer automatically links (joins) multiple tables on the defined relationships. You might also want to select Enable AutoJoin on the Tables/Queries tab. When you select this option and build a query on two tables that aren't directly related, the query designer attempts to link the two tables for you. The query designer looks at the primary key of each table. If it can find a field with the same name and data type in one of the other tables you added to the query designer, the query designer builds the link for you. Some advanced users might prefer to always create these links themselves.

The two tables, tblFacilities and tblReservations, aren't directly related to each other. If you look in the Relationships window (choose Relationships from the Tools menu), you'll see a relationship defined between tblFacilities and tblFacilityRooms on the FacilityID field. There's also a relationship between tblFacilityRooms and tblReservations on the combination of the FacilityID and the RoomNumber fields. So, tblFacilities is related to tblReservations via the FacilityID field, but indirectly. In other words, the FacilityID field in tblReservations is a foreign key that points to the related row in tblFacilities. So, it's perfectly legitimate to build a query that links these two tables on the FacilityID field.

Inside Out
Query joins don't always need to match relationships

It's a good idea to define relationships between related tables to help ensure the integrity of your data. However, you don't need to define a relationship between the foreign key in a table and the matching primary key in every other related table. For example, if table A is related to table B, and table B is related to table C, you don't necessarily need a relationship defined between table A and table C even though table C might contain a foreign key field that relates it to table A. Even when you haven't explicitly defined a relationship between table A and table C, it is perfectly valid to join table A to table C in a query as long as there's a legitimate matching field in both tables.

The upper part of the Query window in Design view should look like that shown in Figure 8-1. Access first links multiple tables in a query based on the relationships you have defined. If no defined relationship exists, and you have Enable AutoJoin selected on the Tables/Queries tab in the Options dialog box (this option is enabled by default), then Access attempts to match the primary key from one table with a field that has the same name and data type in the other table.

Access shows the links between tables as a line drawn from the primary key in one table to its matching field in the other table. As already noted, no direct relationship exists between the two tables in this example. With Enable AutoJoin enabled, however, Access sees that the FacilityID field is the primary key in tblFacilities and finds a matching FacilityID field in tblReservations. So, it should create a join line between the two tables on the FacilityID fields. If you don't see this line, you can click FacilityID in tblFacilities and drag and drop it on FacilityID in tblReservations, just like you learned to do in “Defining Relationships”. You can also choose Join Properties from the View menu and click New in the resulting dialog box to define the two tables and the related fields.

NOTE
If you haven't defined relationships, when you create a query that uses two tables that are related by more than one field (for example, tblFacilityRooms and tblReservations in this database), the Join Properties dialog box lets you define only one of the links at a time. You must click the New button again to define the second part of the join. If you're using drag and drop, you can do this with only one field at a time even though you can select multiple fields in either table window.

In this example, you want to add to the query the FacilityID and FacilityName fields from the tblFacilities table and the ReservationID, EmployeeNumber, FacilityID, RoomNumber, CheckInDate, and CheckOutDate fields from the tblReservations table. (I resized the columns in the query grid in Figure 8-1 so you can see almost all the fields.)


Figure 8-1. A query that selects information from the tblFacilities and tblReservations tables.
When you run the query, you see the recordset shown in Figure 8-2. The fields from the tblFacilities table appear first, left to right. I resized the columns displayed in Figure 8-2 so that you can see all the fields. You might need to scroll right in the datasheet to see them on your machine.

Inside Out
A query is really defined by its SQL

The query designer converts everything you build in a query grid into SQL—the lingua franca of database queries. Access actually stores only the SQL and rebuilds the query grid each time you open a query in Design view. Later in this chapter, we'll examine some of the actual syntax behind your queries, and you can study the full details of SQL in Article 1, “Understanding SQL,” on the companion CD.
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Figure 8-2. The recordset of the query shown in Figure 8-1. The facility information in the drop-down list comes from the Lookup properties defined in the tblReservations table.
Notice the facility name in the column for the FacilityID field from the tblReservations table. (The caption for the field is Facility.) If you check the definition of the FacilityID field in the tblReservations table, you'll see a Lookup combo box defined—the query has inherited those properties. Click in a field in the Facility column in this datasheet, and the combo box appears. If you choose a different Facility name from the drop-down list, you will change the FacilityID field for that reservation. But the room number already in the row might not exist in the new Facility, so you might get an error if you try to save the row. This is yet another example of a business rule that you will have to ensure is verified in a form you create for users to edit this data.

If you choose a different Facility (the FacilityID field in tblReservations), you can see the ID and Name change on the left side of the datasheet. When you change the value in a foreign key field (in this case, the FacilityID field in tblReservations) in a table on the many side of a one-to-many query (there are many reservations for each facility), Access performs an AutoLookup to retrieve the related row from the one side (tblFacilities) to keep the data synchronized. You'll find this feature handy later when you build a form that displays and edits information from a query like this.

Try changing the Facility column (remember, this is the FacilityID field from tblReservations) in the first row from Main Campus Housing A to South Campus Housing C. When you select the new value for the FacilityID field in tblReservations, you should see the ID field from tblFacilities change to 3 and the Name entry (the FacilityName field from tblFacilities) change from Main Campus Housing A to South Campus Housing C. Note that in this case you're changing only the linking FacilityID field in tblReservations, not the name of the facility in tblFacilities. Access is retrieving the row from tblFacilities that matches the changed FacilityID value in tblReservations to show you the correct name.

NOTE
If you change the facility in one of the rows in this query, Access won't let you save the row if the room number in the reservation doesn't exist in the new facility you picked.

One interesting aspect of queries on multiple tables is that in many cases you can update the fields from either table in the query. See “Limitations on Using Select Queries to Update Data” for a discussion of when joined queries are not updatable. For example, you can change the facility name in the tblFacilities table by changing the data in the Name column in this query's datasheet.

CAUTION
In most cases, Access lets you edit fields from the table on the one side of the join (in this case, tblFacilities). Because the facility name comes from a table on the one side of a one-to-many relationship (one facility has many reservations, but each reservation is for only one facility), if you change the name of the facility in any row in this query, you change the name for all reservations for the same facility. 

Although the dangers to doing this are apparent, this is actually one of the benefits of designing your tables properly. If the facility is renamed (perhaps it gets renamed in honor of a beloved ex-president of the company), you need to change the name in only one place. You don't have to go find all existing reservations for the facility and update them all.

You might use a query like the one in Figure 8-1 as the basis for a report on reservations by facility. However, such a report would probably also need to include the employee name and department to be truly useful. Switch back to Design view, click the Show Table button on the toolbar (or choose Show Table from the Query menu) and add tblEmployees and tblDepartments to the query.

TIP
If you have enough room on your screen to place the Database window and the Query window side by side, you can also drag and drop any table or query from the Database window to your query.

You'll run into a small problem when you add tblDepartments to your query: There are two relationships defined between tblDepartments and tblEmployees. First, each employee must have a valid department assigned, so there's a relationship on DepartmentID. Also, any manager for a department must be an employee of the department, and an employee can manage only one department, so there's a second relationship defined between EmployeeNumber in tblEmployees and ManagerNumber in tblDepartments.

The query designer doesn't know which relationship you want to use as a join in this query, so it includes them both in the query grid. If you leave both join lines in your query, you'll see only reservations for managers of departments because the join between EmployeeNumber in tblEmployees and ManagerNumber in tblDepartments forces the query to only include employees who are also managers. You should click on the join line between EmployeeNumber in tblEmployees and ManagerNumber in tblDepartments and press the Delete key to remove the join.

If you're going to use this query in a report, you probably don't need the EmployeeNumber and FacilityID from tblReservations, so you can delete them. Next click on RoomNumber and choose Column from the Insert menu to give you a blank column to work with. You need the employee name for your report, but you most likely don't need the separate FirstName, MiddleName, and LastName fields. Use the blank column to create an expression as follows:

EmpName: tblEmployees.FirstName & " " & (tblEmployees.MiddleName + " ") & LastName

Note that you're using the little trick, which you learned in the previous chapter: using an arithmetic operation to eliminate the potential extra blank when an employee has no middle name. Drag and drop the Department field from tblDepartments on top of RoomNumber in the Design grid—this should place it between the EmpName field you just defined and RoomNumber. Your query grid should now look like Figure 8-3.
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Figure 8-3. Creating a complex query using four tables.
You can switch to Datasheet view to see the results of your work as shown in Figure 8-4.
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Figure 8-4. The recordset of the query shown in Figure 8-3.
Do you notice anything strange about the sequence of rows? Why aren't the rows sorted by facility name and then perhaps employee name? If you were to put the EmployeeNumber back into the query grid and take a look at the data again, you would discover that Access sorted the rows by EmployeeNumber and then by ReservationID. Access looked at all the information you requested and then figured out the quickest way to give you the answer—probably by fetching rows from tblEmployee first (which are sorted on the primary key, EmployeeID) and then fetching the matching rows from tblReservations.

Remember from the previous chapter that the only way you can guarantee the sequence of rows is to specify a sort on the fields you want. In this case, you might want to sort by facility name, employee last name, employee first name, and check-in date. You buried first name and last name in the EmpName expression, so you can't use that field to sort the data by last name. You can find the correct answer saved as qxmplSortReservations in the sample database. (Hint: You need to add tblEmployees.LastName and tblEmployees.FirstName to the grid to be able to specify the sort.)

Building a Query on a Query

When you're building a very complex query, sometimes it's easier to visualize the solution to the problem at hand by breaking it down into smaller pieces. In some cases, building a query on a query might be the only way to correctly solve the problem.

For this set of examples, let's switch to the data in the LawTrack Contacts database. Start Access and open ContactsDataCopy.mdb. Customers who purchase a Single User copy of the software marketed by LawTrack can later decide to upgrade to the Multi-User edition for a reduced price. Assume you're a consultant hired by LawTrack, and the company has asked you to produce a list of all customers and their companies who purchased a Single User copy and then later purchased the upgrade.

To solve this, you might be tempted to start a new query on tblContacts and add the tblCompanies, tblContactProducts, and tblProducts tables. You would include the CompanyID and CompanyName fields from tblCompanies; the ContactID, FirstName, and LastName fields from tblContacts; and the ProductID and ProductName fields from tblProducts. Then you would place a criterion like "Single User" And "Upgrade to Multi-User" on the Criteria line under ProductName. However, any one row in your query will show information from only one contact and product, so one row can't contain both “Single User” and “Upgrade to Multi-User.” (See the discussion in “AND vs. OR.”) Your query will return no rows.

Your next attempt might be to correct the criterion to "Single User" Or "Upgrade to Multi-User". That will at least return some data, but you'll get an answer similar to Figure 8-5. (You can find this query saved as qxmplTwoProductsWrong in the sample database.)
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Figure 8-5. An attempt to find out which contacts have purchased both Single User and the Upgrade to Multi-User.
Because there aren't very many rows in this database, you can see that the answer is Michael Sullivan and Kevin Casselman. But if there were thousands of rows in the database, you wouldn't be able to easily find the contacts who purchased both products. And if you need the output to display in a report, you really need a single row for each contact that meets your criteria.

One way to solve this sort of problem is to build a query that finds everyone who owns Single User and save it. Then build another query that finds everyone who purchased the Multi-User upgrade and save that. Finally, build a third query that joins the first two results to get your final answer. Remember that a simple join returns only the rows that match in both tables—or queries. So, someone who appears in both queries clearly owns both products! Here's how to build the solution.

1. Build the first query to find customers who own Single User.

a. Start a new query on tblContactProducts and add tblProducts to the query. You should see a join line between tblProducts and tblContactProducts on the ProductID field because there's a relationship defined.

b. From tblContactProducts, include the CompanyID and the ContactID fields.

c. Add ProductName from tblProducts, and enter "Single User" on the Criteria line under this field. Save this query and name it qrySingle.

2. Build the second query to find customers who bought the upgrade.

a. Start another query on tblContactProducts and add tblProducts to the query.

b. From tblContactProducts, include the CompanyID and the ContactID fields.

c. Add ProductName from tblProducts, and enter "Upgrade to Multi-User" on the Criteria line under this field. Save this query and name it qryMultiUpgrade.

3. Build the final solution query.

a. Start a new query on tblCompanies. Add your new qrySingle and qryMultiUpgrade queries.

b. The query designer will link tblCompanies to both queries on CompanyID, but you don't need a link to both. Click on the join line between tblCompanies and qryMultiUpgrade and delete it.

c. You do need to link qrySingle and qryMultiUpgrade. Drag and drop CompanyID from qrySingle to qryMultiUpgrade. Then, drag and drop ContactID from qrySingle to qryMultiUpgrade. Because you are defining an inner join between the two queries, the query only fetches rows from the two queries where CompanyID and ContactID match.

d. Add tblContacts to your query. Because there's a relationship defined between ContactID in tblContacts and ReferredBy in tblCompanies, the query designer adds this join line. You don't need this join (the query would return only contacts who have made referrals), so click on the line and delete it. The query designer does correctly create a join line between tblContacts and qrySingle.

e. In the query Design grid, include CompanyName from tblCompanies, and FirstName and LastName from tblContacts. Your result should look like Figure 8-6.

[image: image5.png]¥ Queryl : Select Query.

thiCompanies — aQryMultipgrade thiContacts
arySingle n

[« (CompanyID

(CompanyID (ContactID
(ContactID

]

Field: [CompanyMame Frsthiame Lastiiame.
Table: [tbiComparies thiContacts tbiCantacts
Sort
Show:
Crieria





Figure 8-6. Solving the “contacts who own two products” problem the right way by building a query on queries.
Switch to Datasheet view, and, sure enough, the query gives you the right answer as shown in Figure 8-7.
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Figure 8-7. The two contacts who purchased a Single User edition and later upgraded.
This works because you're using the two queries to filter each other via the join. The qrySingle query finds contacts who own Single User. The qryMultiUpgrade query finds contacts who bought the Multi-User upgrade. The join lines between these two queries ask the final query to return rows only where CompanyID and ContactID in the first two queries match, so you won't see rows from qrySingle that don't have a matching combination of CompanyID and ContactID in qryMultiUpgrade, and vice-versa.

More Info
For more examples of building queries on queries, see Article 1 on the companion CD, “Understanding SQL.”

Using Outer Joins

Most queries that you create to request information from multiple tables will show results on the basis of matching data in one or more tables. For example, the Query window in Datasheet view shown in Figure 8-4 contains the names of facilities that have reservations in the tblReservations table—and it does not contain the names of facilities that don't have any reservations booked. As explained earlier, this type of query is called an equi-join query, meaning that you'll see rows only where there are equal values in both tables. But, what if you want to display facilities that do not have any reservations in the database? Or, how do you find employees who have no reservations? You can get the information you need by creating a query that uses an outer join. An outer join lets you see all rows from one of the tables even if there's no matching row in the related table. When no matching row exists, Access returns the special value Null in the columns from the related table.

Building a Simple Outer Join

To create an outer join, you must modify the join properties. Let's see if we can find any employees who don't have any reservations booked. Start a new query on tblEmployees in the HousingDataCopy database. Add tblReservations to the query. Double-click the join line between the two tables in the upper part of the Query window in Design view to see the Join Properties dialog box shown in Figure 8-8.
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Figure 8-8. The Join Properties dialog box with the second option elected.
The default setting in the Join Properties dialog box is the first option—where the joined fields from both tables are equal. You can see that you have two additional options for this query: to see all employees and any reservations that match, or to see all reservations and any employees that match. If you entered your underlying data correctly, you shouldn't have reservations for employees who aren't defined in the database. If you asked Access to enforce referential integrity (discussed in Chapter 4, “Creating Your Database and Tables”) when you defined the relationship between the tblEmployees table and the tblReservations table, Access won't let you create any reservations for nonexistent employees.

Select the second option in the dialog box. (When the link between two tables involves more than one field in each table, you can click the New button to define the additional links.) Click OK. You should now see an arrow on the join line pointing from the tblEmployees field list to the tblReservations field list, indicating that you have asked for an outer join with all records from tblEmployees regardless of match, as shown in Figure 8-9. For employees who have no reservations, Access returns the special Null value in all the columns for tblReservations. So, you can find the employees that aren't planning to stay in any facility by including the Is Null test for any of the columns from tblReservations. When you run this query, you should find exactly one employee who has no reservation, as shown in Figure 8–10. The finished query is saved as qxmplEmployeesNoReservations in the HousingDataCopy.mdb database.
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Figure 8-9. The design of a query to find employees who have no reservations.
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Figure 8-10. The recordset that shows employees who have no reservations.
Solving a Complex “Unmatched” Problem

As discussed earlier in this chapter, you know that to solve certain types of problems you must first build one query to define a subset of data from your tables and then use that query as input to another query to get the final answer. For example, suppose you want to find out which employees have no reservations in a certain time period. You might guess that an outer join from the tblEmployees table to the tblReservations table will do the trick. That would work fine if the tblReservations table contained reservations only for the time period in question. Remember, to find employees who haven't booked a room, you have to look for a special Null value in the columns from tblReservations. But to limit the data in tblReservations to a specific time period—let's say July and August 2003—you have to be able to test real values. In other words, you have a problem because a column from tblReservations can't be both Null and have a date value at the same time. (You can find an example of the wrong way to solve this problem saved as qxmplEmpNotBookedJulAugWRONG in the sample database.)

To solve this problem, you must first create a query that contains only the reservations for the months you want. As you'll see in a bit, you can then use that query with an outer join in another query to find out which employees haven't booked a room in July and August 2003. Figure 8-11 shows the query you need to start with, using tblReservations. This example includes the EmployeeNumber field as well as the FacilityID and RoomNumber fields, so you can use it to search for either employees or facilities or rooms that aren't booked in the target months.
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Figure 8-11. A query that lists reservation data for particular months.
Notice that if you truly want to see all reservations in these two months, you need to specify a criterion on both CheckInDate and CheckOutDate. Anyone who checked in on or before August 31, 2003—provided they didn't check out before July 1, 2003—is someone who stayed in a room between the dates of interest. You don't want anyone who checked out on July 1 (who stayed the night of June 30, but didn't stay over into July), which explains why the second criterion is >#7/1/2003# and not >=#7/1/2003#. This query is saved as qxmplBookingsJulAug in the HousingDataCopy.mdb database.

Finding Records Across Date Spans

You might be looking at the problem of finding any reservation that crosses into or is contained within a certain date span and scratching your head. You want any reservation that meets one of these criteria: 

· The reservation begins before the start of the date span but extends into the date span.

· The reservation is contained wholly within the date span.

· The reservation begins before the end of the date span but extends beyond the date span.

· The reservation starts before the beginning of the date span and ends after the end of the date span.

You can see these four conditions in the following graphic.
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You might be tempted to include four separate criteria in your query, but that's not necessary. As long as a reservation begins before the end of the span and ends after the beginning of the span, you've got them all! Try out the criteria shown in Figure 8-11 to see if that simple test doesn't find all of the previous cases.

After you save the first query, select it in the Database window and select Query from the New Object toolbar button's drop-down list to start a new query using the first one as input. In your new query, add tblEmployees to the Design grid by choosing Show Table from the Query menu and then selecting tblEmployees in the Show Table dialog box. Access should automatically link tblEmployees to the query on matching EmployeeNumber fields. Double-click the join line to open the Join Properties dialog box, and choose option 3 to see all rows from tblEmployees and any matching rows from the query. The join line's arrow should point from tblEmployees to the query, as shown in Figure 8-12. (When you first add tblEmployees to the query grid, it appears to the right of qxmplBookingsJulAug. I repositioned the field lists with respect to each other. You can grab either field list by its title bar with your mouse to move it.)
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Figure 8-12. An outer join query searching for employees not booked in July and August 2003.
As you did in the previous outer join example, include some fields from the tblEmployees table and at least one field from the query that contains reservations only from July and August 2003. In the field from the query, add the special Is Null criterion. When you run this query (the results of which are shown in Figure 8-13), you should find four employees who haven't booked a room in July and August 2003—including the one employee that you found earlier who hasn't booked any room at all. This query is saved as qxmplEmpNotBookedJulAug in the HousingDataCopy.mdb database.
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Figure 8-13. The employees without any bookings in July and August 2003.
Let's study another example. When you're looking at reservation requests, and each request indicates the particular type of room desired, it might be useful to know either which facilities have this type of room or which facilities do not. (Not all facilities have all the different types of rooms.) You can find a complete list of the room types in the tlkpRoomTypes table in the Housing Reservations application.

To find out which room types aren't in a facility, you might try an outer join from tlkpRoomTypes to tblFacilityRooms and look for Null again, but all you'd find is that all room types exist somewhere—you wouldn't know which room type was missing in what facility. In truth, you need to build a query first that limits room types to one facility. Your query should look something like Figure 8-14.
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Figure 8-14. A query that lists all the rooms and their room types in Facility number 1.
Now you can build your outer join query to find out which room types aren't in the first housing facility. Start a query on tlkpRoomTypes and add the query qxmplRoomsFacility1. Double-click the join line and ask for all rows from tlkpRoomTypes and any matching rows from the query. Add the RoomType field from tlkpRoomTypes and the FacilityID field from the query to the grid. Under FacilityID, place a criterion of Is Null. Your query should look like Figure 8-15.
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Figure 8-15. A query to find out which room types are not in Facility number 1.
If you run this query, you'll find that Facility number 1 has no one-bedroom suites with king bed and kitchenette, no one-bedroom suites with two queen beds, and no simple rooms with only a king bed. In the sample database, you'll find sample queries that return the room types for the other three facilities, so you can build queries like the one in Figure 8-15 to find out what room types are missing in those facilities.

Using a Query Wizard

Every time you have opened the New Query dialog box, you have seen the tantalizing query wizard entries. You can use query wizards to help you build certain types of “tricky” queries such as crosstab queries (discussed later in this chapter) and queries to find duplicate or unmatched rows. For example, you could have used a query wizard to build the query shown in Figure 8-9 to locate employees who have no room reservations. Let's use a query wizard to build a query to perform a similar search in the ContactsDataCopy.mdb sample file to find contacts who don't own any products.

To try this, click the Queries button in the Database window, and then click the New button. This time, select Find Unmatched Query Wizard in the New Query dialog box, as shown in Figure 8-16.
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Figure 8-16. Selecting a query wizard.
The wizard opens a window with a list of tables from which you can select the initial records, as shown in Figure 8-17. If you want to use an existing query instead of a table, select the Queries option. If you want to look at all queries and tables, select the Both option. In this case, you're looking for contacts who haven't purchased any products, so select the tblContacts table and then click the Next button.

In the next window, select the table that contains the related information you expect to be unmatched. You're looking for contacts who have purchased no products, so select the tblContactProducts table and then click the Next button to go to the next window, shown in Figure 8-18.
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Figure 8-17. The first window of the Find Unmatched Query Wizard.
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Figure 8-18. Defining the unmatched link.
Next, the wizard needs to know the linking fields between the two tables. Because no direct relationship is defined between tblContacts and tblContactProducts, the wizard won't automatically pick the matching fields for you. You should click the ContactID field in tblContacts and the ContactID field in tblContactProducts to highlight those two fields. Click the <=> button between the field lists to add those fields to the Matching fields box . Click Next to go to the window shown in Figure 8-19.

NOTE
The Find Unmatched Query Wizard can only work with tables that have no more than one field that links the two tables. If you need to “find unmatched” records between two tables that require a join on more than one field, you'll have to build the query yourself.
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Figure 8-19. The window in which you select the fields to be displayed in a query.
This works just like the Table Wizard you learned about in Chapter 4, “Creating Your Database and Tables.” Choose the fields you want to display (see Figure 8-19) by selecting a field in the left list and then clicking the > button to move the field to the right list. The query will display the fields in the order you select them. If you choose a field in error, highlight it in the right list and click the < button to move it back. You can click the >> button to select all fields or the << button to remove all fields. When you're finished selecting fields, click Next. In the final window, you can specify a different name for your query. (The wizard generates a long and ugly name.) You can choose an option to either view the results or modify the design. So that you can see the design first, select Modify the design and click Finish to open the Query window in Design view. Figure 8-20 shows the finished query to find contacts who have purchased no products.

[image: image20.png]£ thiContacts Without Matching thiContactProducts : Select Query.

thiContacts thiContactProducts

Field: [ContactlD Frstiiame Lastiiame. ContactiD
Table: [tbiCantacts tbiCantacts tbiCantacts thiContactProducts
Sort
Show: ml
Crteria E





Figure 8-20. A query to find contacts who have purchased no products.
If you run this query, you'll find one contact who hasn't bought anything. Perhaps you should schedule a call to him to find out why!

Summarizing Information with Totals Queries

Sometimes you aren't interested in each and every row in your table—you'd rather see calculations across groups of data. For example, you might want the total product purchase amount for all companies in a particular state. Or you might want to know the average of all sales for each month in the last year. To get these answers, you need a totals query.

Totals Within Groups

If you're the housing facilities manager, you might be interested in producing sales and usage numbers by facility or by date range. For this series of exercises, open HousingDataCopy.mdb and start a new query on tblFacilities and add tblReservations to the query design. Include in the field grid the FacilityName field from tblFacilities and the CheckInDate and TotalCharge fields from tblReservations.

Inside Out
When totals queries are useful

I might occasionally build totals queries to display high-level summaries in a report. More often, I create a regular query that fetches all the detail I need and then use the powerful summarization facilities in reports to calculate totals. You'll learn more about summarizing data in a report in Chapter 16, “Advanced Report Design.”

A totals query groups the fields you specify, and every output field must either be one of the grouping fields or the result of a calculation using one of the available aggregate functions. (See Table 8-1.) Because all fields are calculated, you cannot update any fields returned by a totals query. So, you're not likely to find totals queries useful in forms.

This does not mean that learning how to build totals queries is not useful. You need to understand the concepts of grouping and totaling to build reports. You will also find that constructing and opening a totals query in Visual Basic code is useful to perform complex validations.
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To turn this into a totals query, click the Totals button on the toolbar or choose Totals from the View menu to open the Total row in the Design grid, as shown in Figure 8-21. When you first click the Totals button on the toolbar, Access displays Group By in the Total row for any fields you already have in the Design grid. At this point the records in each field are grouped but not totaled. If you were to run the query now, you'd get one row in the recordset for each set of unique values—but no totals. You must replace Group By with an aggregate function in the Total row.
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Figure 8-21. The Total row in the Design grid.
Access provides nine aggregate functions for your use. You can choose the one you want by typing its name in the Total row in the Design grid or by selecting it from the drop-down list. You can learn about the available functions in Table 8-1.

	Table 8-1. Aggregate Functions

	Function
	Description

	*You can change the sort order for new databases you create by choosing Options from the Tools menu and specifying New database sort order on the General tab. The default value is General, which sorts your data according to the language specified for your operating system.

	Sum
	Calculates the sum of all the values for this field in each group. You can specify this function only with number or currency fields.
	

	Avg
	Calculates the arithmetic average of all the values for this field in each group. You can specify this function only with number or currency fields. Access does not include any Null values in the calculation.
	

	Min
	Returns the lowest value found in this field within each group. For numbers, Min returns the smallest value. For text, Min returns the lowest value in collating sequence (“dictionary”* order), without regard to case. Access ignores Null values.
	

	Max
	Returns the highest value found in this field within each group. For numbers, Max returns the largest value. For text, Max returns the highest value in collating sequence (“dictionary”* order), without regard to case. Access ignores Null values.
	

	Count
	Returns the count of the rows in which the specified field is not a Null value. You can also enter the special expression COUNT(*) in the Field row to count all rows in each group, regardless of the presence of Null values.
	

	StDev
	Calculates the statistical standard deviation of all the values for this field in each group. You can specify this function only with number or currency fields. If the group does not contain at least two rows, Access returns a Null value.
	

	Var
	Calculates the statistical variance of all the values for this field in each group. You can specify this function only with number or currency fields. If the group does not contain at least two rows, Access returns a Null value.
	

	First
	Returns the value for the field from the first row encountered in the group. Note that the first row might not be the one with the lowest value. It also might not be the row you think is “first” within the group. Because First depends on the actual physical sequence of stored data, it essentially returns an unpredictable value from within the group.
	

	Last
	Returns the value for the field from the last row encountered in the group. Note that the last row might not be the one with the highest value. It also might not be the row you think is “last” within the group. Because Last depends on the actual physical sequence of stored data, it essentially returns an unpredictable value from within the group.
	


Let's experiment with the query you started earlier in this section to understand some of the available functions. First, you probably don't want to see information grouped by individual date. Data summarized over each month would be more informative, so create an expression to replace the CheckInDate field as follows:

CheckInMonth:  Format([CheckInDate], "yyyy mm")

The Format function works similarly to the table field Format property you learned about in Chapter 4, “Creating Your Database and Tables.” The first parameter is the name of the field or the expression that you want to format, and the second parameter specifies how you want the data formatted. In this case, we're asking Format to return the four-digit year and two-digit month number.

More Info
For more information about Format settings, see “Setting Control Properties.”

Change the Total row under TotalCharge to Sum. Add the TotalCharge field from tblReservations three more times, and choose Avg, Min, and Max, respectively, under each. Finally, add the ReservationID field from tblReservations and choose Count in the Total row under that field. Your query design should now look like Figure 8-22.

Switch to Datasheet view to see the result as shown in Figure 8-23. The sample data file has 180 available rooms in four different facilities. From the results of this query, you could conclude that this company has far more housing than it needs! Perhaps the most interesting row is the eighth one (where the selection arrow appears in Figure 8-23). The five reservations for Housing B in July 2003 show how the various functions might help you analyze the data further.
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Figure 8-22. A query that explores many of the aggregate functions.
Troubleshooting
I didn't specify sorting criteria, so why is my data sorted?

A totals query has to sort your data to be able to group it, so it returns the groups sorted left to right based on the sequence of your Group By fields. If you need to sort the grouping columns in some other way, change the sequence of the Group By fields. Note that you can additionally sort any of the totals fields.
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Figure 8-23. The total revenue, average revenue, smallest revenue per reservation, largest revenue per reservation, and count of reservations by facility and month.
In the drop-down list for the Total row in the Design grid, you'll also find an Expression setting. Select this when you want to create an expression in the Total row that uses one or more of the aggregate functions listed earlier. For example, you might want to calculate a value that reflects the range of reservation charges in the group, as in the following:

Max([TotalCharge]) - Min([TotalCharge])

As you can with any field, you can give your expression a custom name. Notice in Figure 8-23 that Access has generated names such as SumOfTotalCharge or AvgOfTotalCharge. You can fix these by clicking in the field in the Design grid and prefixing the field or expression with your own name followed by a colon. In Figure 8-24, I removed the separate Min and Max fields, added the expression to calculate the range between the smallest and largest charge, and inserted custom field names. You can see the result in Datasheet view in Figure 8-25.

[image: image25.png]Faciitytiame
FacityAddress
FacityCiy
FaciitystateOrprovi
FacitypostalCode

thiReservations

Employeshumber
FacityD
Roamhumber
ReservationDate
(CheckinDate

(Checkoutpate

Fild:
Tabl:
Total;
Sort
Show:
Crieria

TotCharge: TotalCharge

vaCharge: Totaicharge

Ronge: (Max({Totalcharge])-Mn{Totalcharg=T))

mRes: Reservationid

tbReservations

tbReservations

tbReservations

Em

£

Expression

Count





Figure 8-24. Adding an expression and defining custom field names in a totals query.
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Figure 8-25. The query shown in Figure 8-24 in Datasheet view.
Selecting Records to Form Groups

You might filter out some records before your totals query gathers the records into groups. To filter out certain records from the tables in your query, you can add to the Design grid the field or fields you want to filter. Then create the filter by selecting the Where setting in the Total row (which will clear the field's Show check box), and entering criteria that tell Access which records to exclude.

For example, the manager of the Sales department might be interested in the statistics you've produced thus far in the query in Figure 8-24, but only for the employees in the Sales department. To find this information, you need to add tblEmployees and tblDepartments to your query (and remove the extra join line between the EmployeeNumber field in tblEmployees and the ManagerNumber field in tblDepartments). Add the Department field from tblDepartments to your design, change the Total line to Where, and add the criterion "Sales" on the Criteria line under this field. Your query should now look like Figure 8-26.
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Figure 8-26. Using the Department field to select the rows that will be included in groups.
Now, when you run the query, you get totals only for the employees in the Sales department. The result is shown in Figure 8-27.
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Figure 8-27. The recordset of the query shown in Figure 8-26.
Selecting Specific Groups

You can also filter groups of totals after the query has calculated the groups. To do this, enter criteria for any field that has a Group By setting, one of the aggregate functions, or an expression using the aggregate functions in its Total row. For example, you might want to know which facilities and months have more than $1,000 in total charges. To find that out, you would use the settings shown in Figure 8-26 and enter a Criteria setting of >1000 for the TotalCharge field, as shown in Figure 8-28. This query should return one row in the sample database. You can find this query saved as qxmplSalesHousingGT1000 in the sample database.
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Figure 8-28. Entering a Criteria setting for the TotCharge field.
Building Crosstab Queries

Access supports a special type of total query called a crosstab query that allows you to see calculated values in a spreadsheetlike format. For example, you can use this type of query to see total revenue by month for each facility in the Housing Reservations application.

Creating a Simple Crosstab Query

Open the HousingDataCopy.mdb database. To see revenue by facility, you'll need tblFacilities and tblReservations. Start a new query on tblFacilities and add tblReservations. Add the FacilityName field from tblFacilities to the Design grid. Revenue gets collected when the employee checks out, and you want to summarize by month. So, enter RevMonth: Format(CheckOutDate, "yyyy mmm") in the next empty field in the Design grid. This expression returns the year as four digits and the month as a three-character abbreviation. Finally, add the TotalCharge field from tblReservations.

Choose the Crosstab Query command from the Query menu. Access changes your query to a totals query and adds a Crosstab row to the Design grid, as shown in Figure 8-29. Each field in a crosstab query can have one of four crosstab settings: Row Heading, Column Heading, Value (displayed in the crosstab grid), or Not Shown.
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Figure 8-29. A crosstab query in Design view.
You must have at least one row heading field in a crosstab query, and you can specify more than one field as a row heading. Each row heading field must be a grouped value or expression, and the expression can include one or more of the aggregate functions —Count, Min, Max, Sum, and so on. The row heading fields form the columns on the left side of the crosstab. Think of the grouped values of the row heading fields as forming the horizontal “labels” of the rows. In this example, we'll be grouping by the FacilityName field. We'll later modify the basic query we're building here to add a second row heading using Sum—the total value of each facility's reservations.

You must also have one (and only one) field defined as a column heading, and this must also be a grouped or totaled value. These values form the headings of the columns across the crosstab datasheet. Think of a regular totals query where one of the columns “pivots,” and the values in the rows become labels for additional columns in the output. These columns appear sorted in value sequence immediately following the columns you define as row headings. Because the values in the data you're selecting determine the column names when you run the query, you cannot always predict in advance the field names that the query will output.

Finally, you need one (and only one) field designated as the value. This field must be a totaled value or an expression that contains one of the aggregate functions. The value field appears in the cells that are the intersections of each of the row heading values and each of the column heading values. In the following example, the facility names will appear down the left side, the year and month values will appear as column headings across the top, and the sum of the reservation charge for each group for each month will appear in the intersection.

As in other types of totals queries, you can include other fields to filter values to obtain the result you want. For these fields, you should select the Where setting in the Total row and the Not Shown setting in the Crosstab row and then enter your criteria. You can also enter criteria for any column headings, and you can sort on any of the fields.

Troubleshooting
How do I display more than one value in a crosstab?

The fact that a crosstab query can display only one value field in the intersection of row and column headings is a severe limitation. What if you want to display both the total reservation value as well as the count of reservations? One way is to build two separate crosstab queries—one that provides the sum of the total charge as the value field, and one that provides the count of reservations as the value field—and then join the two queries on the row heading columns. That's an inelegant way to do it.

Another solution is to create a simple query that includes all the detail you need and then switch to PivotTable view to build the data display you need. You'll learn about PivotTable and PivotChart views later in this chapter.

To finish the settings for the crosstab query that you started to build in Figure 8-29, in the Crosstab row select Row Heading from the drop-down list under the FacilityName field, select Column Heading under the RevMonth expression, and select Value under the TotalCharge field. Also change the Group By setting under the TotalCharge field to Sum.

Switch to Datasheet view to see the result of your query design, as shown in Figure 8-30. (The remaining column that you can't see in the figure is 2003 Sep.)
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Figure 8-30. The recordset of the crosstab query you're building.
Notice that although you didn't specify a sort sequence on the dates, Access sorted the dates left to right in ascending collating order anyway. Notice also that the month names appear in alphabetical order, not in the desired chronological order.

Access provides a solution for this: You can specifically define the order of column headings for any crosstab query by using the query's property sheet. Return to Design view and click in the upper part of the Query window, and then click the Properties button on the toolbar to see the property sheet, as shown in Figure 8-31.

To control the order of columns displayed, enter the headings exactly as they are formatted and in the order you want them in the Column Headings property, separated by commas. In this case, you are entering text values, so you must also enclose each value in double quotes. Be sure to include all the column headings that match the result of the query. (Notice that I specified all the months in 2003 even though the sample data covers only April to October.) If you omit (or misspell) a column heading, Access won't show that column at all. When you run the query with formatted column headings, you see the recordset shown in Figure 8-32.
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Figure 8-31. Entries in the property sheet that fix the order of column headings for the query shown in Figure 8-30.
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Figure 8-32. A crosstab query recordset with custom headings and custom column order, as defined in Figure 8-31.
CAUTION
Specifying correct column headings can be difficult. You must run your query first to determine what headings you'll see. You might be able to define criteria in your query that guarantee the column headings—for example, you could filter the query to return rows only from a specific year. If you misspell a column heading in the Query Properties window, the real danger is that Access gives you no warning that your query returns columns that aren't in your column heading specification. You'll see blanks in your misspelled columns, and you could mistakenly assume that no data exists for those columns.

Let's add a grand total for each row (the total per facility regardless of month) and do something about the blank cells. Wouldn't it be nice to see a zero in months when there were no reservations?

Switch back to Design view and add another TotalCharge field to the field grid. Give it a name of GrandTotal, choose Sum in the Total row, and Row Heading in the Crosstab row.

Remember the little trick we used earlier to use a plus sign (+) arithmetic operator in a concatenation to remove extra blanks? In this case, we want to do exactly the reverse—wherever there are no values, the Sum returns a Null that we want to convert to a zero. Also, remember that when you concatenate two values with the ampersand (&) operator, that operator ignores Nulls. You can force a Null to a zero by concatenating a leading zero character. If the Sum is not Null, adding a zero in front of the value won't hurt it at all.

In the TotalCharge field you chose as the value field, change Sum to Expression and change the Field line to use this expression:

0 & Sum(TotalCharge)

Any concatenation returns a string value, so you'll need to convert the value back to a currency number for display. There's a handy “convert to currency” function (CCur) that will perform this conversion for you. Further modify the expression to read:

CCur(0 & Sum(TotalCharge))

Switch back to Datasheet view, and your query result should now look like Figure 8-33.
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Figure 8-33. Your crosstab query now shows a grand total on each row as an additional row heading, and all empty cells are filled with zero values.
As with most tasks in Access, there's usually more than one way to solve a problem. You can also generate the missing zero values by using the Null-to-zero function (NZ) in your expression instead of using concatenation. Your expression could look like:

CCur(NZ(Sum(TotalCharge),0))

If you're not quite getting the result you expect, you can check what you have built against the qxmplRevenueByFacilityByMonthXtab sample query you'll find in the database.

Partitioning Data in a Crosstab Query

The total sales by month is interesting, but what can you do if you want to break the data down further? For example, you might want to know the value of sales across a range of room prices. This sort of information might be invaluable to the operator of a commercial hotel. What amount of revenue is the hotel receiving from various room prices?

You'll learn later in Chapter 16, “Advanced Report Design,” that you can ask the report writer to group data by data ranges. Well, you can also do this in a totals or crosstab query. Let's continue to work in the HousingDataCopy.mdb database to see how this works.

Start a new query on tblFacilities and add tblReservations. Add the FacilityName field from tblFacilities, and create a CkOutMonth field by using the Format function to return a four-digit year and month abbreviation as you did earlier. Add the TotalCharge field from tblReservations to the query grid twice. Choose Crosstab Query from the Query menu to convert your query to a crosstab query.

On the Crosstab line, select Row Heading under the FacilityName field, your CkOutMonth expression, and the first TotalCharge field. Change the name of this first TotalCharge field to GrandTotal, and select Sum in the Group By row. For the second TotalCharge field, select Sum in the Group By row and Value in the Crosstab row.

You still don't have a Column Heading field or expression defined, but here's where the fun begins. In this query, your sales manager has asked you for a breakdown of amounts spent per month based on ranges of the DailyRate field. In this database, the lowest daily charge is $40 a day, and the highest is $100 a day. The manager has asked you to display ranges from $40 to $119 in increments of $20 ($40 to $59, $60 to $79, and so on). It turns out there's a handy function called Partition that will split out numbers like this for you. The syntax of the function is as follows:

Partition(<number>, <start>, <stop>, <interval>)

The number argument is the name of a numeric field or expression you want to split up into ranges. Start specifies the lowest value you want, stop specifies the highest value you want, and interval specifies the size of the ranges. The function evaluates each number it sees and returns a string containing the name of the range for that number. You can group on these named ranges to partition your data into groups for this crosstab query. So, the expression you need is as follows:

Partition(DailyRate, 40, 119, 20)

The function will return values “40: 59”, “60: 79”, “80: 99”, and “100: 119”. Add that expression to your query grid and select Column Heading in the crosstab row. Your query should now look like Figure 8-34.
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Figure 8-34. Designing a crosstab query using partitioned values.
Switch to Datasheet view to see the result that should satisfy your sales manager's request as shown in Figure 8-35. Note that I didn't use the trick discussed earlier to fill blank cells with zeros. In this case, the blank cells seem to visually point out the rate ranges that had no sales. You can find this query saved as qxmplRevenueByFacilityByRateRangeXtab in the sample database.
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Figure 8-35. The result of partitioning sales totals on ranges of room rates.
Using Query Parameters

So far you've been entering selection criteria directly in the Design grid of the Query window in Design view. However, you don't have to decide at the time you design the query exactly what value you want Access to search for. Instead, you can include a parameter in the query, and Access will prompt you for the criteria each time the query runs.

To include a parameter, you enter a name or a phrase enclosed in brackets ([ ]) in the Criteria row instead of entering a value. What you enclose in brackets becomes the name by which Access knows your parameter. Access displays this name in a dialog box when you run the query, so you should enter a phrase that accurately describes what you want. You can enter several parameters in a single query, so each parameter name must be unique as well as informative. If you want a parameter value to also display as output in the query, you can enter the parameter name in the field row of an empty column.

Let's say you're the housing manager, and you want to find out who might be staying in any facility over the next several days or weeks. You don't want to have to build or modify a query each time you want to search the database for upcoming reservations. So, you ask your database developer to provide you with a way to dynamically enter the beginning and ending dates of interest.

Let's build a query to help out the housing manager. Start a new query on tblFacilities in the HousingDataCopy.mdb database. Add tblReservations and tblEmployees. From tblReservations, include the ReservationID, RoomNumber, CheckInDate, CheckOutDate, and TotalCharge fields. Insert the FacilityName field from tblFacilities between ReservationID and RoomNumber. Add an expression to display the employee name in a field inserted between ReservationID and FacilityName. Your expression might look like this:

EmpName: tblEmployees.LastName & ", " & tblEmployees.FirstName

Now comes the tricky part. You want the query to ask the housing manager for the range of dates of interest. Your query needs to find the reservation rows that show who is in which rooms between a pair of dates. If you remember from the previous example in this chapter where we were looking for employees occupying rooms in July or August, you want any rows where the check-in date is less than or equal to the end date of interest, and the check-out date is greater than the start date of interest. (If they check out on the beginning date of the range, they're not staying in the room that night.) So, you can create two parameters on the Criteria line to accomplish this. Under CheckInDate, enter: <=[Enter End Date:], and under CheckOutDate, enter: >[Enter Start Date:]. Your query should look like Figure 8–36.
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Figure 8-36. Setting query parameters to accept criteria for a range of reservation dates.
For each parameter in a query, you should tell Access what data type to expect. Access uses this information to validate the value entered. For example, if you define a parameter as a number, Access won't accept alphabetic characters in the parameter value. Likewise, if you define a parameter as a Date/Time data type, Access won't accept anything but a valid date or time value in the parameter prompt. (See Figure 8-38.) By default, Access assigns the text data type to query parameters. In general, you should always define the data type of your parameters, so choose the Parameters command from the Query menu. Access then displays the Query Parameters dialog box , as shown in Figure 8-37.
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Figure 8-37. The Query Parameters dialog box.
In the Parameter column, enter each parameter name exactly as you entered it in the Design grid. If your parameter name includes no spaces or special characters, you can omit the brackets. (In this case, your parameters include both spaces and the colon character—either of which would require the brackets.) In the Data Type column, select the appropriate data type from the drop-down list. Click the OK button when you finish defining all your parameters.

When you run the query, Access prompts you for an appropriate value for each parameter, one at a time, with a dialog box like the one shown in Figure 8-38. Because Access displays the “name” of the parameter that you provided in the Design grid, you can see why naming the parameter with a useful phrase can help you enter the correct value later. If you enter a value that does not match the data type you specified, Access displays an error message and gives you a chance to try again. You can also click the Cancel button to abort running the query. If you click OK without typing a value, Access returns a Null value for the parameter to the query.
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Figure 8-38. The Enter Parameter Value dialog box.
Notice that Access accepts any value that it can recognize as a date/time. If you respond to the query parameter prompts with May 1, 2003, for the Start Date and May 12, 2003, for the End Date, you'll see a datasheet like Figure 8-39.
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Figure 8-39. The recordset of the query shown in Figure 8-36 when you reply with May 1, 2003, and May 12, 2003, to the parameter prompts.
You can find this query saved in the sample database as qxmplReservationLookupParameter.

Customizing Query Properties

Microsoft Access provides a number of properties associated with queries that you can use to control how a query runs. To open the property sheet for queries, click in the upper part of a Query window in Design view outside of the field lists and then click the Properties button. Figure 8-40 shows the property sheet Access provides for select queries.
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Figure 8-40. The property sheet for select queries.
Use the Description property to document what the query does. This description appears next to the query name when you view query objects in Details view in the Database window. You can also select the query in the Database window and open the Properties window to enter this property without having to open the query in Design view.

The Default View property determines how the query opens when you choose it in the Database window and click Open. Datasheet view is the default, but you might want to change this setting to PivotTable or PivotChart if you have designed either of these views for the query. See “Creating PivotTables and PivotCharts from Queries,” for details.

Controlling Query Output

You normally select only specific fields that you want returned in the recordset when you run a select query. However, if you're designing the query to be used in a form and you want all fields from all tables used in the query available to the form, set the Output All Fields property to Yes. It's a good idea to keep the default setting of No and change this option only for specific queries.

Inside Out
Don't change the default setting for the Output All Fields property

You can change the default Output All Fields property for all queries on the Tables/Queries tab of the Options dialog box, but I strongly recommend that you do not do this. Queries execute most efficiently when they return only the fields that you need. Also, when your query includes more than one table and a field exists more than once in different tables, an expression you use to reference the field will fail unless you qualify the field name with the table name. You might include the field only once on the Design grid, but Output All Fields causes the query to include all copies of the field.

You can use the Top Values property to tell Access that you want to see the first n rows or the first x% of rows. If you enter an integer value, Access displays the number of rows specified. If you enter a decimal value between 0 and 1 or an integer less than 100 followed by a percent sign (%), Access displays that percentage of rows. For example, you might want to find the top 10 best-selling products or the top 20% of highest paid employees. Note that in most cases you'll need to specify sorting criteria—perhaps by count of products sold descending or salary descending—to place the rows you want at the “top” of the recordset. You can then ask for the top 10 or top 20% to get the answers you want.

When working in a query datasheet, you can define and apply filters and specify sorting just as you can in a table datasheet. Access stores this filtering and sorting criteria in the query's Filter and Order By properties . When you design a query, you can use the Filter and Order By properties to predefine filtering and sorting criteria. When you open the query and choose Apply Filter/Sort from the Records menu, Access applies the filter and/or sorts the data using these saved properties. If you change the filter or sorting criteria while in Datasheet view and then save the change, Access updates these properties.

You can also affect whether the fields returned by the query can be updated by changing the Recordset Type property . The default setting, Dynaset, allows you to update any fields on the many side of a join. It also lets you change values on the one side of a join if you have defined a relationship between the tables and have enabled Cascade Update Related Fields in the Edit Relationships dialog box. If you choose Dynaset (Inconsistent Updates), you can update any field that isn't a result of a calculation, but you might update data that you didn't intend to be updatable. If you want the query to be read-only (no fields can be updated), choose the Snapshot setting.

WARNING
You should rarely, if at all, choose the Dynaset (Inconsistent Updates) setting for Recordset Type. This setting makes fields updatable in queries that might not otherwise allow updating. Although Access still enforces referential integrity rules, you can make changes to tables independently from each other, so you might end up reassigning relationships unintentionally. You can read about the details of when fields are updatable in a query later in this chapter in “Limitations on Using Select Queries to Update Data.”

Working with Unique Records and Values

When you run a query, Access often returns what appear to be duplicate rows in the recordset. The default in Access 2003 is to return all records. You can also ask Access to return only unique records. (This was the default for all versions of Access prior to version 8, also called Access 97.) Unique records mean that the identifier for each row (the primary key of the table in a single-table query or the concatenated primary keys in a multiple-table query) is unique. If you ask for unique records, Access returns only rows with identifiers that are different from each other. If you want to see all possible data (including duplicate rows), set both the Unique Values property and the Unique Records property to No. (You cannot set both Unique Records and Unique Values to Yes. You can set them both to No.)

To understand how the Unique Values and Unique Records settings work, open the ContactsDataCopy.mdb database and create a query that includes both the tblContacts table and the tblContactEvents table. Let's say you want to find out from which cities you've received a contact over a particular period of time. Include the WorkCity and WorkStateOrProvince fields from tblContacts. Include the ContactDateTime field from tblContactEvents, but clear the Show check box. Figure 8–41 shows a sample query with a date criterion that will show contact cities between December 2002 and March 2003. (Remember, ContactDateTime includes a time value, so you need to enter a criterion one day beyond the date range you want.) You can find this query saved as qxmplNoUnique in the sample database.
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Figure 8-41. A query to demonstrate setting both Unique Values and Unique Records to No when you're using two tables.
If you switch to Datasheet view, as shown in Figure 8-42, you can see that the query returns 39 rows—each row from tblContacts appears once for each related contact event that has a contact date between the specified days. Some of these rows come from the same person, and some come from different people in the same city. The bottom line is there are 39 rows in tblContactEvents within the specified date range.

If you're interested only in one row per contact (per person) from tblContacts, regardless of the number of contact events, you can set the Unique Records property to Yes. The result is shown in Figure 8-43 (saved as qxmplUniqueRecords). This tells us that there were 17 different people who had a contact event within the date range. Again, some of these rows come from different people in the same city, which is why you see the same city listed more than once. The recordset now returns unique records from tblContacts (the only table providing output fields in this query).
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Figure 8-42. The result of retrieving all rows across a join even though the output columns are from only one of the tables.
NOTE
Setting Unique Records to Yes has no effect unless you include more than one table in your query and you include fields only from the table on the one side of a one-to-many relationship. You might have this situation when you are interested in data from one table but you want to filter it based on data in a related table without displaying the fields from the related table.
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Figure 8-43. The result of retrieving unique records across a join, with output from one table.
Finally, if you're interested in only which distinct cities you received a contact from in the specified date range, and you want to see each city name only once, then set Unique Values to Yes. (Access automatically resets Unique Records to No.) The result is shown in Figure 8-44 (saved as qxmplUniqueValues).
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Figure 8-44. The result of setting the Unique Values property to Yes.
When you ask for unique values, you're asking Access to calculate and remove the duplicate values. As with any calculated value in a query, fields in a unique values query can't be updated.

Defining a Subdatasheet

In the previous chapter, I showed you how to work with and modify subdatasheets from query Datasheet view. Now, let's take a closer look at the properties you can set in a query to predefine a subdatasheet within the query. Let's say you want to create a query to show company information and make a subdatasheet available that displays information about the primary contact for the company. You can use the qryContactsDatasheet query that you studied in the previous chapter, but you'll need to modify that query first for this exercise.

In the ContactsDataCopy.mdb database, open qryContactsDatasheet in Design view. To link this query to another that displays company information, you'll need the CompanyID field. Click the Show Table button on the toolbar, and add the tblCompanyContacts table to the query. You should see a join line linking ContactID in the two tables. Add the CompanyID and DefaultForContact fields from tblCompanyContacts to the Design grid. It makes sense to list only the default company for each contact, so add a criterion of True on the Criteria line under the DefaultForContact field. You should clear the Show check box because you don't really need to see this field in the output. Your query design should now look like Figure 8-45. Choose Save As from the File menu, and save the query as qryContactsDatasheetCOID. You can also find this query saved in the sample database as qryXmplContactsDatasheetCOID.
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Figure 8-45. Modifying a query that displays contacts to add a linking CompanyID field.
You need the CompanyID field to provide a link to the outer datasheet that you will build shortly, but you don't necessarily need to see it in your datasheet. Switch to Datasheet view, click in the Company / Org column (this is the CompanyID field), and choose Hide Columns from the Format menu to hide the field. Note that this affects the display only. CompanyID is still a field in the query. Close the query and click Yes when Access asks you if you want to save your layout changes.

Now you're ready to build the query in which you'll use the query you just modified as a subdatasheet. Start a new query on the tblCompanies table. Include the CompanyID, CompanyName, City, and StateOrProvince fields from tblCompanies. Click in the blank space in the top part of the query window, and click the Properties button to open the Query Properties window. Click the Subdatasheet Name property and open the drop-down list. This list shows all tables and queries saved in your database. Scroll down and choose the query that that you just saved—qryContactsDatasheetCOID—and select it as shown in Figure 8-46.

You need to tell your query which field links the query you're creating to the query in the subdatasheet. In Link Child Fields, type the name of the field in the subdatasheet query you just selected that matches a field in the query you're designing—in this case, CompanyID. Note that when you're linking to another table or query that requires more than one field to define the relationship, you enter the field names separated by semicolons. In Link Master Fields, enter the name of the field in the query you're creating that should match the value in the field in Link Child Fields—CompanyID again. (You'll see these same properties again when inserting a subform in a form in Chapter 13, “Advanced Form Design.”)

Two additional properties apply to subdatasheets—Subdatasheet Height and Subdatasheet Expanded. If you leave Subdatasheet Height at its default setting of 0, the subdatasheet area expands to show all available rows when you open it. You can limit the maximum height by entering a setting in inches (or centimeters on a machine whose regional settings are set to the metric system). If the height you specify isn't large enough to show all rows, you'll see a scroll bar to move though the rows in the subdatasheet. If you set Subdatasheet Expanded to Yes, the subdatasheet for every row opens expanded when you open the query or switch to Datasheet view. Just for fun, change this setting to Yes.
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Figure 8-46. Selecting another query to provide the subdatasheet for this query.
TIP
When a property box has a drop-down list of values, you can cycle through the values by double-clicking in the property value box.

Switch to Datasheet view, and your result should look like Figure 8-47.
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Figure 8-47. The query on company information with its contact subdatasheet information expanded.
Do you notice that there are little plus signs on the rows in the subdatasheet? Remember that original qryContactsDatasheet from which you built the new qryContactsDatasheetCOID query, also has a subdatasheet defined. If you click one of the plus signs in the subdatasheet, you'll see the related contact event subdatasheet information from qryContactsDatasheet as shown in Figure 8-48. You can actually nest subdatasheets like this up to seven levels.
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Figure 8-48. Expanding the subdatasheet of the subdatasheet to see contact event information.
You can find this query saved as qxmplCompaniesContactsSub in the sample database.

Other Query Properties

If you designed your database to be shared by multiple users across a network, you might want to secure the tables and grant access to other users only through queries. That way, you can give users specific permissions to tables. When you set the Run Permissions property to User's (the default), users cannot open the query unless they also have permission to access the tables included in the query. If you log on with a name that has full permissions to all tables and then create queries, you become the owner of those queries. You can set Run Permissions to Owner's to allow the person who runs your query to see the data as though they're running under your logon name. The user might not have any permission to access the data in the tables in your query, but you can grant them a filtered view with this technique. Of course, you must grant them permission to run your query. See Chapter 30, “Securing Your Database,” for details about implementing security in a desktop database.

Use the Record Locks property to control the level of editing integrity for a query that is designed to access data shared across a network. The default is No Locks—to not lock any records when the user opens the query. With this setting, Access applies a lock temporarily only when it needs to write a row back to the source table. Select the Edited Record setting to lock a row as soon as a user begins entering changes in that row. The most restrictive setting, All Records, locks every record retrieved by the query as long as the user has the query open. Use this setting only when the query must perform multiple updates to a table and other users should not access any data in the table until the query is finished.

Four of the remaining properties—Source Database, Source Connect Str, ODBC Timeout, and Max Records—apply to dynamically linked tables. You can, for example, run a query against tables in another Microsoft Access database by entering the full path and file name of that database in Source Database. Access dynamically links to the database when you run the query. Use Source Connect Str when you are dynamically linking to an ODBC or non-Access database that requires connection information. ODBC Timeout specifies how long Access will wait (in seconds) for a response from the ODBC database before failing with an error. Use Max Records to limit the number of rows returned to this query from a database server. When you don't specify a number, Access fetches all rows. This might not be desirable when you're fetching data from tables that have hundreds of thousands of rows.

The last property, Orientation, specifies whether you want to see the columns in Left-to-Right or Right-to-Left order. In some languages where reading proceeds right to left, this setting is handy. You can try it out on your system. You'll find that the columns show up right to left, the caption of the query is right-aligned, the selector bar is down the right side of the datasheet, and pressing the Tab key moves through fields from right to left.

Editing and Creating Queries in SQL View

There are three types of queries that you must create in SQL view: data definition queries, pass-through queries, and union queries.

In a desktop application, Access supports a limited subset of the ANSI-Standard SQL language for data definition. You can execute basic CREATE TABLE and ALTER TABLE commands in a data definition query, but you cannot define any Access-specific properties such as the Input Mask or Validation Rule property. The syntax is so limited that I don't cover it in Article 1, “Understanding SQL,” on the companion CD.

When you're using linked tables to a server database system such as Microsoft SQL Server or Oracle, you might need to execute a query on the server that takes advantage of the native SQL supported by the server. You can do most of your work in queries you build in the Access query designer, but the SQL that the query designer builds is only a subset of what your server probably supports. When you need to send a command to your database server in its native syntax, use a pass-through query. If all your data is stored in Microsoft SQL Server, you should build an Access project that links directly to the server data. You can learn about projects in Part IV, “Designing an Access Project.”

So, that leaves us with union queries that you might want to build in SQL view. When you create a query that fetches data from multiple tables, you see the related fields side-by-side in the resulting datasheet. Sometimes it's useful to fetch similar data from several tables and literally stack the rows from different tables on top of one another. Think of pulling the pages containing your favorite recipes out of two different cookbooks and piling them on top of one another to make a new book. For that, you need a union query, and you must build it in SQL view.

Let's say you need to build a mailing list in the LawTrack Contacts application. You want to send a brochure to each primary contact for a company at the company's main mailing address. You also want to include any other contacts who are not the primary contact for a company, but send the mailing to their home address. Sounds easy enough to pull the primary contact mailing address from tblCompanies and the address for everyone else from tblContacts. But how do you get all this information in one set of data to make it easy to print your mailing labels in one pass?

SQL—The Basic Clauses

One way to begin learning SQL (and I strongly recommend that you do), is to take a look at any query you've built in the query designer in SQL view. You can see the SQL view of any query by opening it in Design view and then choosing SQL View from the View menu. You can learn all the details in Article 1, “Understanding SQL,” but a quick overview of the main clauses will help you begin to understand what you see in SQL view.

	SQL Clause
	Usage

	SELECT
	This clause lists the fields and expressions that your query returns. It is equivalent to the Fields row in the query designer. In a totals query, aggregate functions within the SELECT clause, such as Min or Sum, come from specifications in the Totals line.

	FROM
	This clause specifies the tables or queries from which your query fetches data and includes JOIN clauses to define how to link your tables or queries. It is equivalent to the graphical display of table or query field lists and join lines in the top of the query designer.

	WHERE
	This clause specifies how to filter the rows returned by evaluating the FROM clause. It is equivalent to the Criteria and Or lines in the query designer.

	GROUP BY
	This clause lists the grouping fields for a totals query. Access builds this clause from the fields indicated with Group By in the Totals line of the query designer.

	HAVING
	This clause specifies filtering in a totals query on calculated values. This clause comes from the Criteria and Or lines under fields with one of the aggregate functions specified in the Totals line.


First, build a query to get the information you need for each company's primary contact. In the ContactsDataCopy.mdb database, start a new query on tblCompanies. Add tblCompanyContacts and tblContacts and remove the extra join line between the ContactID field in tblContacts and the ReferredBy field in tblCompanies. In the first column on the Field line, enter:

EmpName: (tblContacts.Title + " ") & tblContacts.FirstName & " " &

(tblContacts.MiddleInit + ". ") & tblContacts.LastName &

(" " + tblContacts.Suffix)

Add the CompanyName and Address fields from tblCompanies. In the fourth column on the Field line, enter:

CSZ: tblCompanies.City & ", " & tblCompanies.StateOrProvince & " " &

tblCompanies.PostalCode

Add the DefaultForCompany field from tblCompanyContacts, clear its Show check box, and enter True on the Criteria line. If you switch to Datasheet view, your result should look like Figure 8-49.
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Figure 8-49. The first part of a union query to display names and addresses.
OK, that's the first part. You don't have to save this query—leave it open in Design view. Start another query on tblContacts and add tblCompanyContacts. Create an EmpName field exactly as you did in the first query. In the second column, enter:

CompanyName: ""

Say what? Well, one of the requirements to build a union query is that the two recordsets must both have the exact same number of columns and the exact same data types in the relative columns. A mailing label sent to a home address doesn't have a company name, but you need this field to line up with the ones you created in the first query. In Chapter 15, “Constructing a Report,” you'll see how the Mailing Label Wizard eliminates the blank row that would otherwise be created by including this field.

Add the HomeAddress field from tblContacts in the third column and create this expression in the fourth column on the Field line:

CSZ:  tblContacts.HomeCity & ", " & tblContacts.HomeStateOrProvince & " " &

tblContacts.HomePostalCode

Finally, include the DefaultForCompany field from tblCompanyContacts, clear the Show check box, but this time set a criterion of False. The Datasheet view of this query should look like Figure 8-50.
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Figure 8-50. The second part of a union query to display names and addresses.
Again, you don't have to save this query. Now you're ready to assemble your union query. Go to the Database window, click Queries under Objects, and double-click the Create query in Design view option at the top of the list of queries. You'll see a blank third query window with the Show Table dialog box opened up in front. Click the Close button to dismiss the dialog box. When Access sees that you haven't chosen any tables or queries, it makes SQL the default option on the View button at the left end of the toolbar. Click this button to switch to SQL view on this empty query. You should see a blank window with SELECT; displayed in the upper left corner.

Go back to your first query and choose SQL view from the View menu (or you can open the list on the View button at the left end of the toolbar and choose SQL view there). You should see a window like Figure 8-51.
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Figure 8-51. The first part of your union query in SQL view.
Select all the text you see in this window and copy it to the Clipboard. Switch to the third empty query, and replace SELECT; with the text you copied. Remove the ending semicolon, place the insertion point at the end of the text, press the Enter key, type the word UNION, and press the Enter key again.

Go to your second query, switch to SQL view, highlight all the text, and copy it to the Clipboard. Go back to the third query and paste this text at the end. Your new union query should look like Figure 8-52.
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Figure 8-52. Assembling a union query using the SQL from two other queries.
Switch to Datasheet view to see the final result as shown in Figure 8-53.
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Figure 8-53. The Datasheet view of your new union query.
You should save this query, but you can close and not save the first two queries that you used to build this. You can find this query saved as qxmplAddressesUnion in the sample database. If you want to learn more about SQL, see Article 1, “Understanding SQL,” on the companion CD.

Limitations on Using Select Queries to Update Data

The recordset that Access creates when you run a query looks and acts pretty much like a real table containing data. In fact, in most cases you can insert rows, delete rows, and update the information in a recordset, and Access will make the necessary changes to the underlying table or tables for you.

In some cases, however, Access won't be able to figure out what needs to be changed. Consider, for example, a calculated field named Total that is the result of multiplying two fields named Quantity and Price. If you try to increase the amount in a Total field, Access can't know whether you mean to update the Quantity field or the Price field. On the other hand, you can change either the Price field or the Quantity field and then immediately see the change reflected in the calculated Total field.

In addition, Access won't accept any change that might potentially affect many rows in the underlying table. For that reason, you can't change any of the data in a totals query or in a crosstab query. A Group By field is the result of gathering together one or more rows with the same value. Likewise, a Sum is most likely the result of adding values from potentially many rows. A Min or Max value might occur in more than one row.

When working with a recordset that is the result of a join, Access lets you update all fields from the many side of a join but only the non-key fields on the one side, unless you have specified Cascade Update Related Fields in the relationship. Also, you cannot set or change any field that has the AutoNumber data type. For example, you can't change the ContactID field values in the tblContacts table in the LawTrack Contacts sample application.

The ability to update fields on the one side of a query can produce unwanted results if you aren't careful. For example, you could intend to assign a contact to a different company. If you change the company name, you'll change that name for all contacts related to the current CompanyID. What you should do instead is change the CompanyID in the tblCompanyContacts table, not the company name in the tblCompanies table. You'll learn techniques later in Chapter 13, “Advanced Form Design,” to prevent inadvertent updating of fields in queries.

When you set Unique Values to Yes in the Query Properties window, Access eliminates duplicate rows. The values returned might occur in multiple rows, so Access won't know which one you mean to update. And finally, when Access combines rows from different tables in a union query, the individual rows lose their underlying table identity. Access cannot know which table you mean to update when you try to change a row in a union query, so it disallows all updates.

Query Fields That Cannot Be Updated

Some types of query fields cannot be updated:

· Any field that is the result of a calculation

· Any field in a totals or crosstab query

· Any field in a query that includes a totals or crosstab query as one of the row sources

· A primary key participating in a relationship unless Cascade Update Related Fields is specified

· AutoNumber fields

· Any field in a unique values query or a unique records query

· Any field in a union query

Creating PivotTables and PivotCharts from Queries

Microsoft Access 2002 (Office XP) introduced two very useful new features for tables, queries, and forms—PivotTables and PivotCharts. These are additional views of a table, query, or form that you can design to provide analytical views of your data. These views are built into the objects; they're not implemented via a separate ActiveX control as is the old and venerable Microsoft Graph feature.

Inside Out
You can use PivotTables and PivotCharts on the Web, too!

PivotTables and PivotCharts are part of the Office Web Components that make data access pages work. This means you can include a PivotTable or PivotChart on data access pages you design for your Web site. You can't use the MS Graph custom control in Web pages.

You learned in this chapter that you can build a crosstab query to pivot the values in a column to form dynamic column headings. However, crosstab queries have a major drawback—you can include only one calculated value in the intersection of your row headings and single column heading. PivotTables in Microsoft Access are very similar to the PivotTable facility in Microsoft Excel . You can categorize rows by several values, just like you can in a crosstab query, but you can also include multiple column categories and multiple raw or calculated values in each intersection of rows and columns. As its name implies, you can also pivot the table to swap row headings with column headings.

A PivotChart is a graphical view of the data that you included in your PivotTable. You can build a PivotChart without first defining the PivotTable, and vice versa. When you design a PivotChart, you're also designing or modifying the related PivotTable to provide the data you need for your chart. When you modify a PivotTable, you'll also change (or destroy) the related PivotChart you have already designed.

As you explore the possibilities with PivotTables and PivotCharts, you'll find powerful capabilities to “slice and dice” your data or “drill down” into more detail. Unlike a crosstab query that's built on summarized data, you can begin with a table or query that contains very detailed information. The more detail you have to begin with, the more you can do with your PivotTable and PivotChart.

CAUTION
You might be tempted to design a very detailed query that returns thousands of rows for your user to work with. However, the filtering capabilities inside a PivotTable aren't nearly as efficient as defining a filter in your query to begin with. If you're loading hundreds of thousands of rows over a network, your PivotTable or PivotChart might be very, very slow. You should provide enough detail to get the job done, but no more. You should limit the fields in your query to those focused on the task at hand and include filters in your underlying query to return only the subset of the data that's needed.

Building a Query for a PivotTable

Although you can build a PivotTable directly on a table in your database, you most likely will need a query to provide the level of detail you want to pivot. Let's build a query in the HousingDataCopy.mdb database that provides some interesting detail.

Start a new query on tblFacilities. Add tblReservations, tblEmployees, and tblDepartments. (Be sure to remove the extra relationship between the EmployeeNumber field in tblEmployees and the ManagerNumber field in tblDepartments.) Create an expression to display the employee name in the first field:

EmpName: tblEmployees.LastName & ", " & tblEmployees.FirstName &

(" " + tblEmployees.MiddleName)

In the query grid, include the Department field from tblDepartments, the ReservationID field from tblReservations (we're going to use this field later to count the number of reservation days), the FacilityName field from tblFacilities, and the RoomNumber field from tblReservations. Add an expression in the next field to calculate the actual charge per day. You could use the DailyRate field from tblReservations, but that's not an accurate reflection of how much the room costs per day when the employee stays a week or more. Your expression should look like this:

DailyCharge: CCur(Round(tblReservations.TotalCharge /

(tblReservations.CheckOutDate - tblReservations.CheckInDate), 2))

Remember that you can calculate the number of days by subtracting the CheckInDate field from the CheckOutDate field. Divide the TotalCharge field by the number of days to obtain the actual daily rate. This division might result in a value that has more than two decimal places, so asking the Round function to round to two decimal places (the 2 parameter at the end) takes care of that. Finally, the expression uses the CCur (Convert to Currency) function to make sure the query returns a currency value.

Now comes the fun part. Each row in tblReservations represents a stay of one or more days. In this example, we ultimately want to be able to count individual days to find out the length of stay within any month. To do that, we need to “explode” each single row in tblReservations into a row per day for the duration of the reservation. In this sample database, you'll find what I call a “driver” table—ztblDates—full of dates to accomplish this feat. The table contains date values, one per day, for dates from January 1, 1992, to December 31, 2035. I created this table to “drive” the complete list of dates we need (at least, complete enough for our purposes) against the rows in tblReservations in order to provide the explosion.

Include this table in your query and notice that there's no join line to any of the tables. When you add a table with no join defined to another table or set of records, the query returns the Cartesian product of the two sets of records—every row in the first table or set of records is matched with every row in the second table or set of records. For example, if there are 90 rows in one set and 12 rows in the second set, the query returns 1080 rows (90 times 12). In this case, each reservation will now be matched with each of the separate date values in ztblDates.

As I mentioned earlier, you should try to limit the output of a query that you'll use to build a PivotTable to only the rows you need to solve the problem. Let's say the facilities manager is interested in data for July, August, and September of 2003. Add the DateValue field from ztblDates and enter Between #7/1/2003# And #9/30/2003# under this field on the Criteria line. You have now limited the explosion of rows to dates in the months of interest.

The final step is to further limit the rows created based on the CheckInDate and CheckOutDate fields in tblReservations. Any reservation that crosses the time span of interest is going to be for a few days or a few weeks. Add the CheckInDate and CheckOutDate fields from tblReservations and clear the Show check box under both. On the Criteria row under CheckInDate, enter:

<=ztblDates.DateValue

Under CheckOutDate, enter:

>ztblDates.DateValue

This forces the query to keep any rows where the DateValue field from ztblDates is within the time span of each reservation row. Voilà! You now have one row per date for each reservation. Your query should now look like Figure 8-54.
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Figure 8-54. A complex query for a PivotTable.
To better understand how this query works to expand each reservation into one row per day, take a look at Table 8-2. The table represents expanded rows after applying the final two criteria on the CheckInDate and CheckOutDate fields.

	Table 8-2. How ztblDates Expands Reservation Rows 

	ReservationID
	CheckInDate
	CheckOutDate
	DateValue

	17
	July 1, 2003
	July 7, 2003
	July 1, 2003

	17
	July 1, 2003
	July 7, 2003
	July 2, 2003

	17
	July 1, 2003
	July 7, 2003
	July 3, 2003

	17
	July 1, 2003
	July 7, 2003
	July 4, 2003

	17
	July 1, 2003
	July 7, 2003
	July 5, 2003

	17
	July 1, 2003
	July 7, 2003
	July 6, 2003


The end result is that the query selects only the rows from ztblDates that are within the date range of the individual reservation. Because there's one (and only one) row for every date of interest coming from ztblDates, you end up with one row per day that's within the span of days in each reservation. Figure 8-55 shows you the Datasheet view of your query. You can find this query saved as qxmplReservationsByDay in the sample database.
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Figure 8-55. The reservations for July, August, and September expanded into one row per day.
Designing a PivotTable

Now that you have the data you need, you're ready to start building a PivotTable. From Design or Datasheet view, switch to PivotTable view by choosing PivotTable View from the View menu. You should see a blank PivotTable design area as shown in Figure 8-56. If you don't see the field list as shown in Figure 8-56, choose Field List from the View menu.
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Figure 8-56. The PivotTable design window.
In general, you should use as columns those fields that have the fewest values. If you place too many values across your PivotTable, you'll find that you must scroll left a long way to see all the details. In this case, we're interested in statistics by month, and we know there are only three months of data in the underlying recordset. You'll still be able to show the details by day, if you like, because the recordset includes information by date—you can expand any Months field to show all the days in the month. We might want to see the data organized by department and facility. It might also be interesting to provide an easy way to filter on employee name, but we don't need the data from that field displayed in the table.

Open the DateValue By Month list and drag Months to the Column Fields drop zone. Drag the Department field and the FacilityName field to the Row Fields drop zone. Drag and drop the EmpName field on the Filter Fields drop zone. Finally, drag and drop the ReservationID and DailyCharge fields on the Totals or Detail Fields drop zone. Notice that fields you choose are now highlighted in bold in the PivotTable field list. Within the PivotTable, you can click any plus sign (+) to expand a category or display details, or any minus sign (−) to collapse a category or hide details. If you expand Months in the Column Fields drop zone, the PivotTable automatically adds a Days field to the Columns area. You can also expand the categories in the PivotTable Field List window by clicking the plus sign next to each category. Your PivotTable should look like Figure 8-57.
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Figure 8-57. A PivotTable with fields added to all drop zones.
Now would be a good time to take a quick look at the buttons available on the toolbar that are applicable to PivotTables. Table 8-3 shows you the details.

	Table 8-3. Toolbar Buttons for PivotTables 

	Button
	Name
	Usage
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	AutoFilter
	When highlighted, indicates automatic filtering is active for the PivotTable. You can click this button to remove all filters. If you define a filter, this button becomes highlighted again.
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	Show Top/Bottom Items
	You can select a column or row field and then click this button to define a filter to display only the first or last number or percentage of rows. This feature works similarly to the Top Values property of a query.
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	AutoCalc
	You can select a column, row, or detail/total field and then click this button to insert an aggregate function. The available list of functions includes those you can use in totals queries except for First and Last. (See Table 8-1.) The functions available in AutoCalc are appropriate to the field data type and location on the grid. (For example, you can't Sum a text field.)
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	SubTotal
	You can click on a column or row field and then click this button to insert a subtotal based on the values in that field. You must define an AutoCalc field before you add a subtotal.
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	Calculated Totals And Fields
	You can click this button to insert an expression in the detail/total area that calculates an additional value based on the fields in the recordset.
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	Show As
	After you insert AutoCalc total fields, you can click in a field and then click this button to convert the value to a percentage of the row, column, or grand totals.
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	Collapse
	Click on a row or column field and click this button to collapse all subcategories for this field and show summaries only.
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	Expand
	Performs the opposite of Collapse.
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	Hide Details
	Hides the details for the selected row or column and shows only totals.
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	Show Details
	Performs the opposite of Hide Details.

	[image: image69.png]



	Refresh
	Refetches the underlying data. You might need to do this if others are sharing the data and updating it.
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	Export to Microsoft Excel
	Exports your PivotTable in XML format to an HTML (.htm, .html) file and opens it in Microsoft Excel.
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	Field List
	Opens or closes the PivotTable field list.
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	Properties
	Opens or closes the Properties window.


You're going to need some total calculations for your PivotTable. Click anywhere in the Reservation ID column, click the AutoCalc button to drop down the list of available functions, and select Count. Click anywhere in the DailyCharge column, click the AutoCalc button, and select Sum. Click the Daily Charge column heading and then click the Hide Details button to show only totals. Your PivotTable should now look like Figure 8-58. (I closed the PivotTable field list to show you more of the PivotTable.)
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Figure 8-58. Adding two totals calculations and hiding all the details.
There are literally hundreds of properties you can set in a PivotTable. Let's change the captions of the two totals fields to something more meaningful. Click on the Count Of Reservation ID field and then click the Properties button on the toolbar to open the Properties window as shown in Figure 8-59.
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Figure 8-59. The Properties window for a field in a PivotTable.
As you can see, you can modify the text format on the first tab. You can also drop down the Select combo box to choose any other element you have defined thus far. The Properties window changes depending on the type of element you choose. Click the Captions tab and change the caption to Room Days. Go back to the Format tab, choose Sum of Daily Charge (Total) from the Select box, click the Captions tab again, and change the caption to Revenue.

You could spend a couple of days playing around in this PivotTable to see what else you can do. One last thing we might want to do before turning this into a PivotChart is to actually pivot the table. You do that by grabbing the fields in the column area and moving them to the row area and vice-versa. I decided I'd rather see details about departments first, then facility usage within department, so I placed Department to the left of FacilityName when I moved the fields. You can see the final result in Figure 8-60.
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Figure 8-60. A pivoted PivotTable showing only totals.
If you switch to Design view, you can open the Properties window for the query and set the Default View property to PivotTable. I saved this query as qxmplReservationByDayPT in the sample database. You should save this query under a new name so that you can start fresh building a PivotChart in the next section.

Designing a PivotChart

Designing a PivotChart is almost as easy as building a PivotTable. You will most likely use PivotCharts in reports (as an embedded subform) and in data access pages, but you can also create a PivotChart view of a table, query, or form. As mentioned earlier when discussing PivotTables, you most often need to start with a query to pull together the information you need.

To start building a new PivotChart from scratch, open the qxmplReservationsByDay sample query again and switch to PivotChart view. You can see the PivotChart design window in Figure 8-61.
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Figure 8-61. Beginning to design a PivotChart on a query.
Notice that the filter area is still near the top left corner of the window. However, the area for data fields is now along the top of the gray chart drawing area in the center. Drop fields that you want to use for data points along the bottom axis in the bottom left corner. Drop fields that you want to use for the vertical axis on the right center area. To begin designing your PivotChart, expand DateValue By Month in the field list and drag and drop Months onto the Drop Category Fields Here area. Next, drag and drop Department onto the Drop Series Fields Here area on the right.

TIP
You can switch directly into PivotChart view from the Design view or Datasheet view of any query. If you haven't previously defined the PivotTable, you can still create your chart by dragging and dropping fields from the field list. Keep in mind that any change you make in PivotChart view also changes what you see in PivotTable view. If you want to keep separate PivotTable and PivotChart views, you should save two versions of your query.

We don't have anything charted yet, so drag the DailyCharge field from the field list to the Data Fields area along the top of the chart. Notice that the chart assumes we want to Sum the field. If you had added the ReservationID field, you would have to click on the Sum of Reservation ID field , click the AutoCalc button, and change the calculation to Count. Your PivotChart should now look like Figure 8-62.

This doesn't look all that informative yet, but we're starting to make some progress. It would be nice to add a title, a legend (a description of each of the colored bars), and a vertical axis with some values. You might also want to display the actual value of each bar at the top of it. Let's get started.

First, open the Properties window (click the Properties button on the toolbar) and choose Chart Workspace in the Select box on the General tab as shown in Figure 8-63. (Notice as you go through this exercise that the tabs available in the Properties window change as you select different objects on your PivotChart.)
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Figure 8-62. Creating totals to display in a PivotChart.
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Figure 8-63. Adding a title and legend to the PivotChart workspace.
Click the Title and Legend buttons on the left under Add to create these elements on your PivotChart. Click on Chart Workspace title that you just added (or choose Title in the Select box on the General tab), click the Format tab, and change the caption to something like Revenue by Month and Department. Notice that you can also change the font, font size, font color, and position of the title on this tab.

Go back to the General tab and select Chart Workspace again. Click the Series Groups tab to see the settings in Figure 8-64. On this tab, you can select one or more items in the Series box and create a separate set of plot bars by placing them in their own group. For each group, you can also add an axis and specify its location. Click on group 1 in the lower Add axis box , select Left in the Axis position list , and click the Add button to create the axis.
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Figure 8-64. Adding an axis to your PivotChart.
Finally, go back to the General tab and select the four values in the Select box for the Department field one at a time, beginning with Finance. You'll see buttons to Add Data Label, Add Trendline, or Add Errorbar as shown in Figure 8-65. Select Add Data Label for each department name to add the total value at the top of each column.
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Figure 8-65. Adding labels to data points.
Your PivotChart should now look like Figure 8-66.
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Figure 8-66. A PivotChart to show revenue totals by month and department.
Inside Out
Manipulating the caption of a data field in a PivotChart

If you think about it, you went to some trouble to assign a different caption to Sum of DailyCharge when you built the sample PivotTable. There's actually no way to correct the caption of a data field in PivotChart view. I recommend that you save what you've done so far, and then switch to PivotTable view, hide the details, and change the caption for Sum of DailyCharge to Revenue as you did earlier. When you switch back to PivotChart view, you'll find the new caption displayed. You can find this chart saved as qxmplReservationByDayPC in the sample database.

If you want to see what your PivotChart might look like plotted in a different way, you can click the Chart Type button on the toolbar to open the Properties window with the PivotChart workspace selected and the focus on the Type tab. The chart we've been building thus far is a simple column chart, but you can choose from Bar, Line, Smooth Line, Pie, Scatter, and several other options. Be aware that changing the chart type often throws away some detail settings, so you might have to tweak properties again to get exactly what you want.

Now that you understand the fundamentals of building complex select queries and working with PivotTables and PivotCharts with Access, you're ready to move on to updating sets of data with action queries in the next chapter.
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